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directly from Microsoft Excel

© 2005 IBM Corporation

Data Transfer Overview

» Uses the iSeries database server to transfer data to and from DB2
database files and iSeries source physical files

 Provides an SQL-like interface to allow full file SELECT or customized
queries including joins, sorting, and record grouping

« Capable of transferring data to and from many popular PC file types
 Provides access to iSeries file members
 Transfers may be run interactively, in batch mode, programmatically, or

why “i"? it's simple.
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Data Transfer Overview

Data Transfer is limited to transferring source physical files and data physical
files to PC file types and PC file types to the source and data physical files on the
iSeries. Transferring other types of files to and from a PC and the iSeries
requires using other methods. Some other types of files that reside on the
iSeries are stream files or flat files such as those stored in the Root or NetWare
portions of the iSeries Integrated File System. These files may be accessed
using the methods listed below.

iSeries NetServer through 'shares’

iSeries Navigator Integrated File System (IFS) support
File Transfer Protocol (FTP)

The IBM Toolbox for Java IFS classes

iSeries Access for Web
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Components of a Data Transfer

Supported transfer request file types

, * Data Transfer From iSeries
cata e — .DTF - New request type used in iSeries Access
EEEEEE — .TTO - Request type used in XD1 and DOS Extended clients
— .DT - Request type used in Windows 3.1 client
— .RTO - Rumba transfer request file
« Data Transfer To iSeries
DTHSF — .DTT - New request type used in iSeries Access
e — .TFR - Request type used in XD1 and DOS Extended clients
—.DT - Request type used in Windows 3.1 client
— .RTO - Rumba transfer request file
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Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
¢ Scheduling Data Transfers

 Using the Excel Add-in

« Using Data Transfer with a Web server

» Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer
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Basic Data Transfer

Setting up the library list

© Data Transfer To iSeries
Fle Wew Iools Help

Upload file to iSeries
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Optional: To aid us
when we are looking
for files, we need to
add the libraries to
the library list.

E—————————
File name:

iBeigs————————————————

System:

Library/Fils{Member:

To set properties go
to the File menu and
select Properties.

Transfer

Properties

Conversions | Libraty List | Display | Connection | Startup |

These libraries are temporarly added to the iSeries job library
lst while this data ransfer request s used.
Series lbrary |mw5 Add |
@ Beginning O End
Libtary Narne: [Type | = Bemave
Qs User —I
QGPL System
QTEMP System
ODEVELOP Spstem |
DBLOSYS System
OBLDSYSR Spstem |
0k | cawdd | gk | He |
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Basic Data Transfer

What is the iSeries Database File Wizard?

* The wizard creates a:
— File Description File (FDF)
— Database file on the server

* The wizard does not do the actual data transfer to the iSeries

© 2005 IBM Corporation
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Basic Data Transfer

Starting the iSeries Database File Wizard

Start the Create
iSeries Database
File tool by
selecting it from the
Tools menu or by
clicking on its icon
in the toolbar

o LY .
|

Data Tran_fer To iSeries [_[C1x]
File View TooRN\Hslp
S

FC =

File name

Welcome

iSeries

System:

—

Library/File[Member

This wizard allovs you ta create an iSeries database
file: from an existing PC file.

“rou will be required to specify the name of the PC
file: from which the iS eries file wil be based. the:
name of the iSefies file which to create, and several
ather necessary details.

ek [[THat ] cancel | Hep |

© 2005 IBM Corporation

why “I"? it's simple.



IBM eServer iSeries

Basic Data Transfer

Selecting the PC file that contains your data

Create iSeries Database File [ x]

PC File Mame

“what is the name of the PC file which contairs your
data?

Browse

< Back I Mext » I Cancel Help

© 2005 IBM Corporation why *I"? it's Simple.
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Basic Data Transfer

Selecting the PC File Type

Create iSeries Database File [ ]

File Type:

\what is your PC fle type?

Eile type:

123 [Lotus]

< Back I Hext > I Cancel Help
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Basic Data Transfer

The File Description File panel

Create iSeries Database File

Create File Description File

‘what is the name of the file description file pou
would ke to create?

Browsse

< Back I Hext > I Cancel Help
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Basic Data Transfer

The Change Data Format Options panel

Create iSeries Database File [ x]

Change D ata Format Options
To properly create an iSeries database file, the comect
fotrnat of wour data rust be provided

Options such as date format and decimal separatar
st b set b match your data

If these options are not changed, default values are
used. This could result in data corruption or failure
when transfering data to the new database file.

Ta set the praper famat options for pour data, press
Formnat Optians.

Fomat Options.

<Back [ Wewr | canca | Hep |
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Basic Data Transfer

The Scan PC File panel

Create iSeries Database File [ ]

Scan PL File

To create an iSeries database file the PC file
must be scanned to deteming its data layout

Selsct Start Soan ta begin the scan

[ art Sean |

¥ Eirst ro

< Back I Mext > I Cancel Help
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Basic Data Transfer

The Contents of PC File panel

Create iSeries Database File [ x]

Contents of PC File

Eielow is a list of fields which the scan operation
determined the PC file contained. These field
definitions will be: used to craate the iSeries File.

Field \ Tupe | Length\ -
CUSNUM NUMERIC 3
LETHAM CHARACTER a

INIT CHARACTER 3 —
STREET CHARACTER 12

ary CHARACTER E
STATE CHARACTER 2 ~
4 »

Details...

<Back [ Wewr | cancal | Hep |
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Basic Data Transfer

The Field Details panel

Field Details [ 2] x]
Mame: W
Deseiptior: |
Type [cHeRacTER =1
Length: 8 3 Allocate: o 3
Sode [T H padhg [T
cesip: [OERAULT
Default ['DEFALLT
I~ Null capable

¥ Include in file description file

ok | cencel | Help

©2005 IBM Corporation Why " it's S|mp|e.
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Basic Data Transfer

The System Name panel

Create iSeries Database File [ x]

System Hame

“wihere should your database file be created?

[Beties server

|MYSYSTEM| =l

< Back I Mext > I Cancel Help
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Basic Data Transfer

The iSeries File and Library panel

Create iSeries Database File

iSeries File and Library
Ywhat is the name of the file which wil contain
your data? For example, TESTLIB/TESTFILE

The file you spesify must ot alieady exist in the
specified library and you must have authority to
wiite to the ibray.

Library/File:

Browse

< Back. I Hext > I Cancel Help
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Basic Data Transfer

The File Description Text panel

Create iSeries Database File [ x]

File Description Text

“fou can associate a line of text with the file which
deseiibes the contents of the file.

File text

My customer infarmatior]

<Bsck | Met> | Cancel Help
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Basic Data Transfer

The Confirm Create Options panel

Create iSeries Database File

Confirm Create Options

iSeries server:
IMYSYSTEM

LibranyéFile:
WD:CUSTDMEH

PC file description file:

Select Next to create the iSeriss database file and
the PL file description file.

<

Back I Mext > I Cancel Help
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Basic Data Transfer

The final panel - your file has been

© 2005 IBM Corporation Why ? it's Simp|e.

created!

Create iSeries Database File [ x]

Congratulations!

“ou have successtully created an iSeries database
file.

Use Data Transfer To iSeries to anster data from
your PC file to the new database file.

Press Finish to retum to Data Transfer To iSeries.

< Back

Cancel Help

2005 1BM Corporation Why i"? it's Simple.
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Basic Data Transfer

Returning to Data Transfer To iSeries

:8 Data Transfer To iSeties [_C]

File Wew Took Help

S W S

F‘E\

File name: C:bemphdiransterucustomer 123 Browse.

Systen: MYSTYSTEM |

Library/File{Member)

|INFD/CUSTUMEH Eowse...
Details...

[ Tramsfer data to Series |

© 2005 IBM Corporation Why "7 it's SImple.
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Basic Data Transfer
Key points about the iSeries Database File Wizard
« Creating the table and FDF does not do the data transfer

 Plan ahead by increasing lengths if necessary
» Do not include character and numeric data in the same column

© 2005 1BM Corporation w‘lly .i'? it's Simple.
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Basic Data Transfer

8 Data Transfer To iSeries

File View Took Hslp

Data Transfer to iSeries: Specifying iSeries File Details

B

File name: C:htemphdtransfericustomer. 123 Browss.

iSer
System:

MTSTSTEM >

Library/Fils(Member]

|\NFD/CUSTDMEH

Browse..
Details...

Tiansfer data to iSeries

IBM eServer iSeries

Basic Data Transfer

© 2005 IBM Corporation
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Data Transfer to iSeries: iSeries File Details - upload options

iSeries File Details [ 2] x]
~PLfi
¥ {132 B e desciiption:
File: name: IIZ'\lamp\dtlansler\:ustnmel FOF Browse...
File e [estiTen: =]

Translate from: — [ASCI ~| taEBCODIC

Eoded Character Seb0:

—

- iBeries fil
Create iSeries obiject
ety st

s fle e

Field pefererice fe name:
Fecordlenihs

Autherfy

File text:

No, replace member anly -
& Data € Source
Browse
52 =
Read/wiite -

0K | Cencel | Help
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Data Transfer Usage

« Basic Data Transfer

¢ Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

 Using the Excel Add-in

» Using Data Transfer with a Web server

« Using the Data Transfer Query Builder

« Tips and Tricks with Data Transfer

© 2005 IBM Corporation Why "i"? it's Slmple.
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Saving the request

Data Transfer To iSeries
Fle Wew Touks Help

Clicking File->Save As allows

Running Data Transfer by Clicking an Icon

S

B W E =
you to save the request.

PC.
’V File niame: C:\emphdiransfericustomer. 123 Browse...

Library/File{tember]

System: M5 YSTEM b

|INFD/EUSTDMEH

Browss
Details

| Transter data to iSeries

©2005 IBM Corporation Why “i"? it's Simple.
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Running Data Transfer by Clicking an Icon

Auto-run/Auto-close support

rroverses T

Clicking File->Properties allows e [ i T e S

you to customize properties Request oplions

related to this data transfer. J¥ Run iansfer request automaticall
¥ Close on completion

©2005 IBM Corporation why ""? it's Slmple.
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon

&0 dtransfer [_TO[ ] Transfer to iSeries Complete [<]
Fle Edt Vew Favortes Took Help ‘i
GBak - o - 3] | @search FyFokders @[ Tiansfer stalstcs:
Address [l Ciitemplctransfer x| P
N o '§ | Flows ransfered: 12
= i —
customer, 123 customer.FOF [0 ‘q
A
ot

Type: Data Transf [474 bytes [\ My Computer v

©2005 IBM Corporation Why “i"? it's Simple.
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Running Data Transfer by Clicking an Icon

Batch transfer command interface

« RTOPCB

— Does batch data transfers from iSeries to PC
* RFROMPCB

— Does batch data transfers from PC to iSeries
« RXFERPCB

— Does batch data transfers from iSeries to PC

— Does batch data transfers from PC to iSeries

©2005 IBM Corporation Why " it's S|mp|e.
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Running Data Transfer by Clicking an Icon

Data Transfer from iSeries: Batch transfer command interface
RTOPCB [/S] [[/I] [filename [/C] [...] 1] [[1] /F list file] ]
/S Show transfer statistics.

filename An iSeries to PC transfer request (.TTO or .DTF),
Rumba (.RTO), or Windows 3.1 (.DT) file transfer

request.
IC Process next file independent of previous file.
/l Ignore warnings.
IF Process files within list file (one filename per line).

list file A file containing a list of transfer files to process.

Examples:
RTOPCB c:\temp\test.tto
RTOPCB /S c:\temp\test.tto /C c:\temp\trans.dtf
RTOPCB /S /F c:\temp\transfer.dtf

©2005 IBM Corporation Why “i"? it's Simple.
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Running Data Transfer by Clicking an Icon
Data Transfer to iSeries: Batch transfer command interface
RFROMPCB [/S] [[/1] [filename [/C][...]]] [/1] [/F list file] ]

/S Show transfer statistics.
filename A PC to iSeries file transfer request (.TFR or .DTT),
Rumba (.RTO), or Windows 3.1 (.DT) file transfer request.

IC Process next file independent of previous
file.
IF Process files within list file (one filename per line).

list file A file containing a list of transfer files to process.

Examples:
RFROMPCB c:\temp\test.tfr
RFROMPCB /S c:\temp\test.tfr /C c:\temp\trans.dtt
RFROMPCB /S /F c:\temp\transfer.dtt

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Running Data Transfer by Clicking an Icon

Data Transfer between iSeries: Batch transfer command interface

RXFERPCB request userlD password

request - Fully qualified file name of any Client Access upload or download
request of type .DTF, .DTT, .TTO, or .TFR.

userlD - A valid iSeries user profile for the system specified in the request.

password - A valid password for the specified user profile.

Examples:
RXFERPCB c:\temp\upload.dtf myuserid mypassword
RXFERPCB c:\temp\download.dtt myuserid mypassword

©2005 IBM Corporation Why “i"? it's Simple.
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Running Data Transfer by Clicking an Icon

Incoming Remote Command (IRC)

* Installable option of iSeries Access
« Gives iSeries users ability to start remote commands on a PC

* Message logged in the iSeries Access for Windows History log identifying
what was run

« CWBRXD
— Name of program that controls Incoming Remote Commands

— Runs as a Windows service called iSeries Access for Windows Remote
Command.

* RUNRMTCMD
— iSeries server CL command
— Used to send PC command requests to the PC running the IRC service.

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Running Data Transfer by Clicking an Icon
Shortcut to the Data Transfer command line interface
Update Customers Properties HEBE

To create a new shortcut: General Shoteut | Options | Fort | Layout | Colors | Securty ]
= Right click on an open area of Windows f]  usecisme:

Explorer (or My Computer)
=» Select New -> Shortcut

Target type:  Application

Target location: Client Acsess

= Find and select the RXFERPCB, RTOPCB, Targe Frogiam Fies UM\ et AocessWhampeh. e
or RFROMPCB program in the Client Access
Folder ¥ Hunin sepsrate memoy space. | Aun as different user

= Name the shortcut

= Right click on the new shortcut and select
properties from the menu

=» Add the full path of the transfer request to run "
after the command Comment |

=» Select to run minimized _EndTaget. | Ghange con.,|

Startin I"E “Program Files\BMA\Client Access”

Shorteut ey INDnE

0k | cancel | o |

© 2005 IBM Corporation Why i"? it's Simple.
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon

& dtransfer [ [O][x]

Fle Edt Vew Favortes Took Help |

Back - = - [ | @search [Foders §F | ?

address [ Ciltempichransfer =] @ee
i FOF !43
= Iz m—
E B:
customer.123  customer.FOF - mycustome, .. lipdate ™
{Custamers:
|+ objectis) [e.85KB My Computer 7

© 2005 IBM Corporation Why "7 it's SImple.
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Data Transfer Usage

* Basic Data Transfer

* Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

 Using the Excel Add-in

« Using Data Transfer with a Web server

» Using the Data Transfer Query Builder

* Tips and Tricks with Data Transfer

© 2005 1BM Corporation w‘lly .i'? it's Simple.
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Scheduling Data Transfers

Add a scheduled task

* iSeries Access for Windows Scheduled Task Wizard
does not provide a scheduler
program. For this example, we
use Microsoft's Task Scheduler
application.

« To access Microsoft's Task
Scheduler, go to your Control
Panel, select Scheduled Tasks,

This wizard helps you schedule & task for Windows
to perform,

ou select the proaram you want Windaws ta run,
and then sehedule it for @ converient time.

Click Next ta continue.

and select Add Scheduled Task.

Cancel

< Back

© 2005 IBM Corporation
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Scheduling Data Transfers
Choose the application to schedule
* Click Browse [scheduled Task Wizasd _______H|

* Choose the RXFERPCB.EXE,
RTOPCB.EXE or
RFROMPCB.EXE program
located by default in:

C:\Program Files\IBM\Client Access

LClick the program pou want Windows to un,
To see mare programs, click Browse.

Applicalion Version

Aciobat Reader 4.0 4,05 =

[B5] #:ctiveix Contiol Test Container 608063

[l Address Book. £.00.2800.11..

B2 tuddiess Book Palm Syne Instal 1,0,0,5

[ ddress Book Palm Sync Re... 4.78.0.25

() AD5M Backup Client 3.1.0.1

[t ——, =l
<Back Wi | Caned |

© 2005 IBM Corporation
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Scheduling Data Transfers

Choose how often to run the task

Scheduled Task Wizard [ ]

Type @ name for this task, The task name can be
the same nama as the progiam name

|Updale Custormers D aily

Peiform this task:

* Daly

" weekly

" Monthly

" Dne time only

" “wihen my computer starts
" “when| Iog on

< Back I et > I Cancel

© 2005 IBM Corporation Why "7 it's SImple.
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Scheduling Data Transfers

Choose the time to run the task

Scheduled Task Wizard [ x]

Selact the time and day you want this task to start
Start time:
a004M ==
Pertorm this task:
& EveryDay
 Weekdays

© Every [ _‘3 days

Start date

9/ 7/2003  x

<Bsck [ Hes | Cancel

©2005 IBM Corporation Why “i"? it's Simple.
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Scheduling Data Transfers

Choose the user ID to run the task

Scheduled Task Wizard [ ]

Enter the name and password of a user. The task wil
run as if it wers started by that user

Enter the user name: lmyusend—
Entar the password lm—
Confirm password: l—

< Back Cancel

© 2005 IBM Corporation Why ? Il's SImple.
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Scheduling Data Transfers

Verify summary information

Scheduled Task Wizard [ x]

You havs successfully scheduled the following task:
Update Customers Daily

Windows will perform this task
At 800 AM every day, stating 3/7/2003

en advanced properties for this task when | clicki
ish, H

Click Finish to add this task to pour Windows schedule.

< Back I Firish I Cancel

©2005 IBM Corporation Why i"? it's Simple.
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Scheduling Data Transfers

Add the transfer request to run

Update Customers Daily [2]x]

Task | Schedhie | Settings | Securty |

. MOdlfy the Run line to include the ﬁ CAwINNTAT askstUpdate Custamers Dl job
transfer you want to run

Fiun: I:cess\lfmmpch exe” "C:Memphdiranster\ mycustomers. dit”!

Browse..

Start in I”E'\F‘mgram Filesh|BMA\Clignt Access”

Comments: ’

Run as ryuserid Set password..

[¥ Enabled [scheduled task runs at specified time)

0K | Cancel Apply

© 2005 IBM Corporation Why .i-? it's Simp|e
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Scheduling Data Transfers
Viewing scheduled tasks
B3 scheduled Tasks [_[O] <]
File Edit ‘“iew Favortes Tools Advanced Help |
(=Back ~ = - | Qi5earch [ Folders £ | 5B X = | E-
Address IIEI Scheduled Tasks j Pen
g | [ IJ ame * | Schedule | Mext Run Time | Last Run Time I Status
E)add scheduled Task
Update Cuskomers Daily AE5:00 AMevery d...  S:00:00 AM ... Mever

Scheduled Tasks

This Folder contains tasks you've
scheduled for Windows, Windows
automatically performs each task at
the scheduled time,

For example, you can schedule a time
For Windows to clean up yaur hard disk
by deleting unnecessary files.

Select an item ta view its description,

4 |

|2 object{s) | |

wl=

© 2005 IBM Corporation Why i"? it's Simple.
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Data Transfer Usage

« Basic Data Transfer

* Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

e Using the Excel Add-in

» Using Data Transfer with a Web server

« Using the Data Transfer Query Builder

« Tips and Tricks with Data Transfer

©2005 IBM Corporation Why " it's S|mp|e.
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Using the Excel Add-in
Data Transfer from iSeries
Library: QIWS
Table: QCUSTCDT
[ Eile Edit Yiew Insert Format Iools Data Window Help =18 x|
DERER¥ iead - -~ |azstiipen 208
arial -u-|B7u= BHs %, 94 & -6-A-2
Al ha =]
[ 1 [ K [ L [ wm [ W [ o [ P [ @ =
] 5
2
RN
[ 4|
A
e
7
N
ER
o
[
Mz
3]
[ 14
14| 4 » | p}\Sheetl { Sheetz £ Sheet3 /
Ready T I

©2005 IBM Corporation Why “i"? it's Simple.



IBM eServer iSeries

Using the Excel Add-in lient A1
EE

What is the Excel Add-in?

« Available with Microsoft Excel 97, Excel 2000, and Excel XP.

* Use this support by:
— Clicking on the Data Transfer upload or download button on the Excel toolbar
— Using the options on the Data menu bar

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Using the Excel Add-In

Installing the Excel Add-In

* Open Microsoft Excel
» Click Add-Ins from the D) Fle Edt Wiew Insert Format | Tols Dsta Window Help =18]x|
Tools menu DEE SRY[4&Ysdn. 7 Lrasltl @8 -0

i el -0 .| p B 8%, WE_-2-A2
* Click the Browse... R Share Workbook...
button A |I B | C  TrackChanges b ‘ F ‘ G ‘ H | L=
i . 1 IMerge Workbooks, ., nl
* Locate the path in which |2 Protecton '
you |nsta”ed Cllent Z Onling Collaboration ¥
5
Access i R,
. 7 »
* Double click on the (5] \ o ©
folder named 'Shared’ |2 tzo

1

« Double click on the [11]

4|4 [ M\Sheetl | SheetZ £ She

CWbthIa f||e Ready
 Click the OK button

Custamize, ..

Options. ..

©2005 IBM Corporation Why “i"? it's Simple.
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Using the Excel Add-In

Data Transfer from iSeries: Transferring data into Excel

A Microsoft Excel - Book1

» Select Data ->

&) Bie Edt View Insert Format ools Data Window Help

18| x|

Transfer Data From/To  nugapyjsmee- - ez iniiweén * 08
iSeries | il |- A7
A - B
[ 1 [ ® [ C [ @ [ n ] o o
-or- L1 ol
2
=
. n
 Click one of the Data k3
Transfer icons on the 7
il
toolbar la|
|10
[11]
[ 12|
113 ]
14
|44 M Sheetl J SheetZ ﬂ Sheetd ,0'

Ready | [ [

© 2005 IBM Corporation
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Using the Excel Add-in

Data Transfer from iSeries: The Transfer Request panel

why “i"? it's simple.

Ready

==

© 2005 IBM Corporation Why i"? it's Simple.

o]

Concel |

Help

B Microsoft Excel - Book1 M= E3
J@ File Edt View Insert Format Tools Data Window Help -8 x|
DeHalRy | i2ad|lo-«-azA£243 a0 I @Da
| aris ‘SB%, BB E| DAY
Al - =
[ J | K [ L [ wm [ w [ o [ P | a —
: C
2
B Transfer Request [z1x]
4] Transfer Frequest
|5 | & i
|6 -
[ 7 | € Create fiom file [*.dif, * tho, * dt, * 1ta]
| 8 | Browse:
| 9
110}
|11 Stanting cell position
4] 4 ¥ [bi}\Sheett  Sheetz [ Sheets / [¥ Includs column headings
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Using the Excel Add-In

Data Transfer from iSeries: Creating a new data transfer request

Data Transfer from iSeries

Spstem Mame:

‘Where is pour data located?

iSeries server:

< Back I Hext » I Cancel Help

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Using the Excel Add-In

Data Transfer from iSeries: Choose the file to download

Data Transfer from iSeries

i5eries File and Library

\what library and fie(s] contains your data? For
example, QIWS/QCUSTEDT of
QlwS/GCUSTCDT TESTLB/TESTFILE

“fiou can browse for available libraries and files
by presssing tie browss buttan, Typing in the
library name and pressing browse will browse
the available files in that library.

Browse... I

< Back I Hext > I Cancel Help

©2005 IBM Corporation Why “i"? it's Simple.
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Using the Excel Add-In

Data Transfer from iSeries: Customize the Data Transfer request

Data Transfer from iSeries [ x]

Custamize File Transfer

‘o can customize how your data is fransfened. By
default, all your data will be transfered

To select which data you want to transter, press Data
Options

Data Options..

To change how your data s formated, press Farma
Options

Fomat Options...

To change rurrtime options, press Properties.

Propsties

<Back  [Heds | Cencel | Hep |
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Using the Excel Add-In

Data Transfer from iSeries: Customizing Data Options

Change Data Options

why “i"? it's simple.

» Customizing Data Options allows you  *"*
to set options like: o

— what fields are retrieved

Select  [§

— the ordering of the data |

— only retrieve data based on certain e |

conditions gt |
Qrder by

™ Betumn records with missing fields

I~ Erable group functions

0K I Cancel

Details...

Help

10 O | I 1 | KT | K | KT

© 2005 IBM Corporation
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Using the Excel Add-In

Data Transfer from iSeries: Customizing Format Options

Change Format Options [ 7] =]

Date/Time | Decimals | Miso |

~Da
Date format: [MD'Y] Month D
Dgte separater.  [1/] Slash JEa| change Format Options [21x]
Date/Time  Desimals | iz |
~Tim
Time format: B
Time forma IHMS] Hous inutes Seconds | 5 forore g
E : Change Format Options [2]x] I
Time separator [:] Calon j
[ — DaterTime | Decimals Miss |
. ~Sor
Desimal separator. (] Perind |
[ ok | cawe | an | he BRI

ok I Cancel Apply Hel

Tiable;

- Languag

Language i5eries Job Default i
LLanauage I

0K | Caedd || gl | Heb |
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Using the Excel Add-In

Data Transfer from iSeries: Customizing run-time options

« Conversions

— Allows for the enablement of special
data conversions and for error logging

e Library List

Properties

. [ Lo
« Display [ Bttt

Conversions | Librsry List | Display | SGL | Connection | Startup |

Data conversion

why “i"? it's simple.

position of untranslatable fields

* SQL
e Connection
— Can configure signon and security

options
« Startup
— Can enable option to run transfer 5 |[ = el ek

request automatically later

© 2005 IBM Corporation
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Using the Excel Add-In

Data Transfer from iSeries: Specify a file name

Data Transfer from iSeries

Save request to file

‘fou can specify a file name to store your request
information

IF pou save pour request to a file, pou can wn the
1equest again without having ta réconfigure your
options.

IF pous choose not to sawe the information to a file,

the information will anly be used for the durstion of
this request.

File name;

C:stemphdtianster customerdata, dtf

< Back Firish Cancel Help:

© 2005 1BM Corporation why ? it's simple.

IBM eServer iSeries

Using the Excel Add-In

Data Transfer from iSeries: Viewing the results

EdMicrosoft Excel - Book1 H= E3 I
|EY Fle Edit view Insert Format Tools Dats window Help ;Iilil‘
DEHERY s BRS o -c- @z s 8liBsox -3, 00
| arial -0 - B 1o [® 2, @8 ,'&'i'v|
A1 =]
B C D E | F [ 6 [ H [ T 7T [ 3
1 [CUSNUM ILSTNAM INIT STREET CITY STATE  ZIPCOD |CDTLMT CHGCOD BALDUE COTDUE
[ 2 | 938472 Henning G KK 4859 Elm - Dallas T 7H217 5000 3 i
| 3 | 839283 Jones ED 216 MWy 1:Clay MY 13041 400 1 100
[ 4 | 392859 Vine =R PO Box 75 Broton T 5046 700 1 439
| 5 | 930485 Johnson J A 3 Alpine W Helen GA 30545 9999 2 39875
| B | 397267 Tyron W E 13 Myrtle [Hector MY 14841 1000 1 0
| 7 | 389672 Stevens WL 208 Snow Denver GO 80226 400 1 5575
| B | 845283 Alison J3 787 Lake [lsle L5 56342 5000 3 10
| 8 | 475935 Doe JW 58 Archer Sutter CA 9EBRS 700 2 250
[ 10| B93829 Thomas AN 3 Dove CinCasper WY 82609 9999 2 0
[ 11| 593029 Wiliams ED 485 SE 2 4Dallas T 75218 200 1 25
[ 12| 192837 |Lee FL 5963 Oak Hector  NY 14841 700 2 4835
[ 13| 563990 Abraham M T 392 Mill Stlsle LU 56342 9999 3 500
14
4 [ 4[> [#]'Sheet1 { sheetz f sheet3 [4]
Ready [ [ [0 [
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Using the Excel Add-In

Data Transfer to iSeries: Notes

 Support for uploading data added in V5R1

Create new file and member based on iSeries file
Create new file and member based on spreadsheet
— Create new member

Replace member

Append to existing member

© 2005 IBM Corporation

IBM eServer iSeries

« Support allows the following functions for transferring data to the iSeries:

why “i"? it's simple.

Using the Excel Add-in

Data Transfer to iSeries: Highlighting the data

E Microsoft Excel - Book1

1«1

5\5 Edit View Insert Format Tools Data Wwindow Help -8 5||
DEHERY|[tepRS - = |z stiildw -2 D3
arial co-BIU(E=E=E 8%, @Y% =E - AhA

A1 | =| CUSNUM

A B C D E F G 1 J K 3‘

13| 563990 Abraham MT 392 MillStisle MM 56342 9999 3 &0 o)

‘ﬂJ:I

Ready |1 [5UM=7931048.25

[ I | B
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Data Transfer Usage

« Basic Data Transfer

* Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

* Using the Excel Add-in

* Using Data Transfer with a Web server
« Using the Data Transfer Query Builder

« Tips and Tricks with Data Transfer

© 2005 IBM Corporation

IBM eServer iSeries

why “i"? it's simple.

Using Data Transfer with a Web server

HTML File support - Updating a web server on iSeries

Data Transfer to

Workstation -
‘.
11—
— ‘—.—
Send HTML to iSeries
Web Server (file system)

Client browser
views HTML on
iSeries Web Server

-

© 2005 IBM Corporation
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Using Data Transfer with a Web server

HTML File support - Updating a web server on another machine

Data Transfer to
Workstation
HTML File
Generated
at PC

Send HTML to
Web server

Client browser
views HTML on
Web Server

AlIX or NT Web
Server
/-

Client PC

© 2005 IBM Corporation Why .--? it's Simp|e.
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Using Data Transfer with a Web server

Downloading a file to HTML

E [T

Fle View Help

&= 3|

Systemname:  [MySYSTEM |

File name: 0iwS/ACUSTCOT =] Bowse.
Data ptions

~FC

Dutput device: — [HyperTent Markup Language (HTML] 7| Details
(o e [Citemphdtansfermydata him Browss
Farmat Clptions..

\ Transter data fiom Beiies |

© 2005 IBM Corporation Why i"? it's Simple.
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Using Data Transfer with a Web server

Setting HTML properties

° F|Ie HTML Details HE
« Document Fie | Document| Table | Caption| Row | Cel | Template |
. . . I~ {lise auto sizing
— Specify a title and timestamp ‘i;;;};umiﬁ;";ie & ke
* Table ¥ Eromat before oversnie
. . . Translation and charset
— Specify spacing, alignment, and other table ———
i © asll
er)pertles ]
° Captlon Charset [windows1252
— Specify whether to add a caption for your
table
* Row
e Cell 0K | Caneal Aoty Help
e Template

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Using Data Transfer with a Web server

HTML Template support - enhancing web pages

HTML Details [ 2] %]

HTML Template allows iSeries tabular
data to be inserted into a pre-
formatted HTML document at a ? Use HTHL template fle

specified location. The location is Tempstefis

defined by an embedded template [Eerte _Bowe |

Embedded template tag:

tag. [e-Te8tET >

Fie | Document| Table | Caption | Fiow | Cell  Template |

The template document may contain
graphics, links, frames, and any other
HTML elements you provide.

Cancel Apply Help

©2005 IBM Corporation Why “i"? it's Simple.
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Using Data Transfer with a Web server

Using HTML Template Files

<HTML>

<HEAD>

<TITLE>Sample HTML Code</TITLE>
</HEAD>

<BODY>

<H1>Customer Data</H1>

<l-- TABLE1 -->

</BODY>

</HTML>

When the transfer is run, the template file will be used as a base for the new HTML file.
When data is received from the iSeries, the data will be formatted and will inserted in place
of the <!-- TABLEL1 --> tag.

© 2005 IBM Corporation Why "i"? it's Slmple.
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Using Data Transfer with a Web server
DATALINK data type support

Transferring the DB2 UDB for iSeries DATALINK type to a HTML file will produce
active links within your HTML File.

CUSTNAM | ADDRESS PHONE WEBSITE

IBM iSeries Rochester, MN 800-426-3333 | http://www.ibm.com/eserver/iseries/index.html

COMMON Chicago, IL 800-270-8223 | http://www.common.org/index.html

©2005 IBM Corporation Why “i"? it's Simple.
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Using Data Transfer with a Web server

Viewing the results

3 RCHASDSB - QIWS/QCUSTCDT - Microsoft Internet Explorer

File Edit Wew Favortes Tools Help
Address |@ \templdtransfer\mydata.htm
\(CUSNUM [L.STNAM INTT STREET | CITY [STATE [ZIPCOD [CDTLMT|CE
038472 |Heming GK (50  IDallas TX  [75217  [5000 3
Elm Ave
839283 [Jones BD %;,?SI,\EW Clay NY  [13041 400 1
392859  [Vine S S SS Box |poton[VT  |s046  [700 1
938485 [Tohnson JA %V‘:}l,pme Helen [GA (30545  |0999 2
13
397267 (Tyron  WE Myrtle |[Hector NY (14841 (1000 1
Dr
‘\I I [ lann I I II I I _»lﬂ
@] Done [T & vty Computer 7
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Using Data Transfer with a Web server

Movement of data

« Data Transfer may be used as an data utility in e-business processes.

— May be used to upload gathered transactions to the iSeries from a PC server
acting as the e-business interface.

— May be used by CGI programs on the PC Server to build standard PC files
which may then be sent to customers through the web.

— May be used to generate HTML files to be published on a web server.

— ActiveX objects (or RXFERPCB) may be used in 3-tier to run data transfer
from a Windows Web Server.

©2005 IBM Corporation Why “i"? it's Simple.
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Data Transfer Usage

« Basic Data Transfer

* Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

 Using the Excel Add-in

» Using Data Transfer with a Web server

e Using the Data Transfer Query Builder
« Tips and Tricks with Data Transfer

© 2005 IBM Corporation Why "i"? it's Slmple.
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Using the Data Transfer Query Builder

Starting the Data Transfer query builder

21 Data Transfer From iSeries = B
File Wew Help

BEEE

Systemname:  [MYSVSTEM |

File name: =] Brawse.
|

PC

Quiput device:  [Display = Detis..
File ame: [ Eiowse.
Farrnat Oplions.

Transter data from iSeries |

©2005 IBM Corporation Why “i"? it's Simple.
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Using the Data Transfer Query Builder
Setting up a query

Change Data Dptions

Join by

Giroup by

Select

OR o |

Having |

Order by

Fietun records vith missing fields
I~ Enable gron

0k | Camcel | Detals. | Hep

1 K | T | K | K | KT

© 2005 IBM Corporation Why “i"? it's SImple.
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Using the Data Transfer Query Builder

Select fields to transfer from the iSeries

Receive Request Details
Select | where | Order By |
Field [ Desciiption [ Tupe [ Length]  Digit[ 1=
CUSNUM CUSTOME..  ZONED 3 3
————p | LSTHAM LASTNAM..  CHAR 8 0
INIT FIRSTAND... CHAR 3 0
STREET STREETA.. CHAR 13 0
Ty CITYFIELD  CHAR g 0
STATE STATE 4BB.. CHAR 2 o=
4] | »
Function
ANG =
COUNT
MK
MIN
= |
Select clause

0k | Cancel s | He |

© 2005 1BM Corporation w‘lly .i'? it's Simple.
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Using the Data Transfer Query Builder

Creating a where clause

Receive Request Details [ 7] =]
Select Where | Dider By |
Field | Description [ Type [ Length]  Digt] (=
CUSNUM CUSTOME.. ZONED 3 3
LSTNAM LAST NAM.. CHAR 8 0
INIT FIRST AND... CHAR 3 i
STREET STREETA..  CHAR 13 0
oy CITYFIELD  CHAR 5 0
STATE STATE ABB.. CHAR 2 0 o~
4| | »
Mot Function: Test Others
NOT | [CHAR ﬁl < ﬂ A
CURRENT <= oR
DATE <
DAY
rave =l F |
where clause:
[LSTMAM = Henning] =]
0K | Cancel oo | Heb |

2005 IBM Corporation
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Using the Data Transfer Query Builder

Ordering data

Receive Request Details HEBE
Select | Where Order By |
- Order b
Fied [ Deseription | Tupe [ Lengh[ Digit[1~
CUSNUM CUSTOME. ZONED 5 6
LSTNAM LAST NAM...  CHAR 8 i
INT FIRSTAND... CHAR 3 0
STREET STREETA.  CHAR 13 0
Ty CITYFIELD  CHAR 5 0
STATE STATE ABE.. CHAR 2 0 -
4| | »
Eunction:
BV =
COUNT
M
MIN
i ]
Order by clause:
CUSNUM DESC =l
ok | Cancel soob | Heb |

2005 IBM Corporation
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Using the Data Transfer Query Builder

Multi-file joins

Receive Request Details
Select| where | Drder By JoinBy |
~doin’by
Field [ Desciiption [ Tvpe [ Lengh[ Digi[ 1=
TICOTOUE  CREDITDU. ZONED B 5
T2 CLISHUM LONG ) 5
T2LSTHAM CHAR g 0
T2INIT CHAR 3 0|
T2.5TREET CHAR 13 0
T200TY CHAR 6 0o~
| | »
Test: DOthes:
B AND
=
Led
Join by clause:
T1.CUSNUM = T2CUSNOM =l
Cancel boh | Heb |

© 2005 IBM Corporation
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Using the Data Transfer Query Builder

Record grouping

Receive Request Details [ 7] =]

Select| Where | Having | Order By Group By |

~ Giroup B
Field [ Desciiption | Tups [ Length]  Digt] (=
CUSNUM CUSTOME..  ZONED 3 3
LSTHAM LAST NAM..  CHAR 8 i
INIT FIRST AND..  CHAR 3 o
STREET STREETA. CHAR 13 0
CTYFIELD  CHAR & 0
STATE STATE ABE.. CHAR 2 0 =
4] | »

Group by,

Bl =l

0k | Cancel o | hep |

© 2005 IBM Corporation Why i"? it's Simple.
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Using the Data Transfer Query Builder

Conditional grouping using Having

Receive Request Details HEBE
Conditional record grouping from a Selec| here g | 0erby | Growp |
Group By operation may be done by e
o . i | Not: Function: Test Functior Dthesrs:
SpeCIfylng a aVIng Clause. NOT AVG < <constanty (AND
AW aR
(1= COUNT
MIN Mo
SUM MIN
SUM
Having clause:
(COUNT()=1] =l
-]
T | cancel o | hep |

© 2005 IBM Corporation why " it's Simple.

IBM eServer iSeries

Using the Data Transfer Query Builder

Activating the Native SQL Interface

21 Data Transfer From iSeries M= B
Eile i Hely

Conversians | Library List| Display 8L | Connection | Stantus | |—

iSeies— SOL optior: i
— {

A Native SQL interface is
provided for power users of
for situations where the
Data Transfer format does
not provide enough
functionality

" Process SELECT as Data Transfer famal
ECT as native 500 J

File name

T —

Dutput de

I
il pame J
!

B 0K | Cancel o | Heb |

TTEReIEr Oata Hom ISenes T

©2005 IBM Corporation Why i"? it's Simple.
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After choosing to process
your statement as Native
SQL, the Data Options
button activates a Native
SQL panel

IBM eServer iSeries

The Native SQL
interface allows you to
type in a free form
SELECT statement. A
list of files and columns
in those files are
provided to help you
build your statement

Finding the Native SQL Interface

! Data Transfer From iSeries

File View Hslp

Using the Data Transfer Query Builder

A E @

File name:

System name:

[MrsvsTEM

=

Iulwsfucusmm

\ Data Options.

=] Browse.

~FC

File e

Dutput device: ID\spIay

| Details.

Browise:
Format Options..

\ Transfer data fiom eries

© 2005 IBM Corporation

Using the Native SQL Interface

Using the Data Transfer Query Builder

21 Data Transfer From iSeries =
Change SQL Select Dptions HEBE
SOL Select statement [
~ieries
System name:
File name: =l
Calumns in filefs),
Field [ Desciiption [ Tupe [ Lemgth[ =]
CUSNOM CUSTOME.. ZONED 3 J
rPC LSTHAM LAST MAM... CHAR 8
i Ly FIRSTAND.. CHAR 3
Quiputdevie: | s7ReET STREETA.  CHAR 13
oTY CITYFIELD  CHAR 6 =
File pame: d b
Library/File{Mbr),
|DIWS/E!EUSTEDT
0k | Cencal Help

© 2005 IBM Corporation
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Data Transfer Usage

« Basic Data Transfer

* Running Data Transfer by Clicking an Icon
e Scheduling Data Transfers

 Using the Excel Add-in

» Using Data Transfer with a Web server

« Using the Data Transfer Query Builder

e Tips and Tricks with Data Transfer

© 2005 IBM Corporation Why "i"? it's Slmple.
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Tips and Tricks with Data Transfer

. - Avtech.sho...
File Edit View Rows Help
MAME AMT DATE
Bob 100,20 2005-02-23
Janet 200,12 2004-01-02
Ed 42,12 2004-02-21
Elizabeth 350,13 2003-12-22
Ralph 175.00 2004-10-17

© 2005 IBM Corporation Why i"? it's Simple.
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Tips and Tricks with Data Transfer

* Renaming a column

* Reordering columns

* CAST'ing a column

« Scalar functions

» Working with date/time/timestamp fields
» Working with CCSID 65535 fields

© 2005 IBM Corporation Why "i"? it's Slmple.
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Summary

« Take advantage of all the ways you can use Data Transfer
— Running requests by clicking an icon
— Scheduling data transfers
— Using the Excel Add-in
— Using with a web server
— Running advanced queries
— Using ActiveX Automation Objects

©2005 IBM Corporation Why “i"? it's Simple.
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iSeries Access for Windows — Sessions in Orlando

1. 22MP - iSeries Access for Windows: What’s New
23MP - iSeries Access Data Transfer: Tips and Techniques

25MP - iSeries Access for Windows: Security and
Communications Tips

26MP - iSeries Access for Windows in a .NET World
32MP - Everything you wanted to know about PC5250 emulation
33MP - Performance Tune iSeries Access ODBC Driver

54MN - MS Office and Client Access Integration Session 1:
Setup and Overview

8. 55MN — MS Office and Client Access Integration Session 2;
Basic Functions

9. 56MN — MS Office and Client Access Integration Session 3:
More Functions

wnN

N o ok

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Session title: iSeries Access Data Transfer —
Tips and Techniques

Session ID: 409159

Agenda Key: 23MP

Speakers:  Brent Nelson

©2005 IBM Corporation Why “i"? it's Simple.
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Appendices

« Components of a Data Transfer Notes
« Administering Access to Data Transfer
» Data Transfer ActiveX Automation Objects

© 2005 IBM Corporation

IBM eServer iSeries

Components of a Data Transfer

« Data Transfers involve 4 basic components
— PC File
— An iSeries Database or Source Physical File
— File Description File (FDF)
— New or existing transfer request

© 2005 IBM Corporation
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Components of a Data Transfer

Component I: The PC File
« A PC file is a standard "flat file" located on (or to be created on) your
network or workstation.
 Data Transfer supports many popular PC file formats
— Lotus 1-2-3 (.123) and Lotus 1-2-3 version 4 (.wk4)
— ASCII Text (.txt)
— Basic Random and Basic Sequential
— Microsoft Excel (BIFF) versions 3, 4, 5, 7, and 8 (.xls)
— Comma Separated Variable (.csv)
— Data Interchange Format (.dif)
— DOS Random, including type 2
— Tab Delimited Text (.txt)
— No Conversion (EBCDIC)
— Hypertext Markup Language (.htm, .html)

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Components of a Data Transfer:
PC File Types

Data Transfer supports many popular PC file formats when transferring data to or from the iSeries.
However, some rules apply when performing a data transfer, especially uploading data to the iSeries.

Download
* The PC file type to download to must be able to hold the data from the iSeries file. For example,
downloading to a BIFF3 (Excel version 3) file limits character fields to 256 characters and only
allows 16,385 rows in a spreadsheet.

Upload
« If uploading to an existing iSeries file, the format of the data in the PC file must match the format of
the data in the iSeries file.
« If the PC file has column names those names must match the names in the File Description File
and the iSeries file.
« The HTML file type is not supported for upload.
« Uploading to a database file (table) requires that you have a File Description File (FDF) to match
your PC file.
Uploading to a source physical file with a file type other than ASCII text will only send the first column
of data from the PC file. If more than one column exists in the PC file, you will get a message stating
that extra data was found at the end of the file and will be truncated.

©2005 IBM Corporation Why “i"? it's Simple.
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Components of a Data Transfer

Component II: An iSeries Database or Source Physical File

Transferring data to or from the iSeries requires you to specify either a database table(s) or
source physical file. Each of these file types may contain multiple members.

Database File
An iSeries file in the form of a relational table. It has a specific layout composed of various
types of columns with various lengths.

Source Physical File

An iSeries file normally contains 3 columns. A SRCSEQ, SRCDAT, and SRCDTA column.
The first column is a sequence number. The second column is a date, and the last column
contains your data. The first two columns are six bytes each, and the last column may be
variable length.

© 2005 IBM Corporation Why "i"? it's Slmple.

IBM eServer iSeries -t

Components of a Data Transfer
Component lll: The File Description File (FDF)

A file description file (FDF) is a PC file used to describe a PC data file. A file description file is
required when transferring data to a database file on the iSeries.

An example file description file:
PCFDF

PCFT 19

PCFO1,1,1,1,1

PCFL Name 1 8

PCFL Address 1 13

PCFL Zip 2 6

PCFL Phone 1 8

PCFL Balance 2 8/2

©2005 IBM Corporation Why “i"? it's Simple.
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Components of a Data Transfer
File Description File (FDF)

The PC File Description File (FDF) contains various record types.
The first line of an FDF file must contain PCFDF. This line indicates that the file is an FDF.

The next line of the file, PCFT, indicates the PC file type. File type 19 signifies an FDF for use with the
Lotus 123 Version 9 file type. Values for other file types are as follows:

ASCIl Text = 1 Dos Random = 2 BasicSequential = 3 Basic Random = 4

DIF =5 No Conversion = 6 Dos Random =7 Dos Random Type 2 =8
BIFF 4 =9 BIFF3 = 10 BIFF5 = 11 CSv =12

Lotus WK4 =13 Tab Delimited Text = 14 BIFF7 = 15 BIFF8 = 16

Lotus 123 =17 Excel Add-in = 18 Lotus 123 Version 9 = 19

The PCFO line indicates PC file options. These options include date and time formatting and the
decimal separator to use.

The PCFL lines contain the fields of the PC file. These are in order, top to bottom, listing fields in the
PC file. The first column is the field name, for example, Address, the next column is the data type, and
the final column is the length. The most common data types are ‘1’ for character and '2' for numeric.

TheI third column may contain two numbers separated by a ‘/'. This indicates that the field has numeric
scale.

© 2005 IBM Corporation Why .i-? it's Simp|e.
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Components of a Data Transfer

Component IV: The Transfer request
* What is a transfer request?

— A transfer request is a PC file created by and used with Data Transfer for
storing options and settings for the transferring of data to or from the iSeries.

* Some of the items stored in a transfer request include:

— iSeries system name

— iSeries file name(s)

— PC file name

— PC File Description File name

— PC file type

©2005 IBM Corporation Why “i"? it's Simple.
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* Some options include:
— Microsoft System Policy support
— Application Administration
— Exit Programs
— Object-level database security

© 2005 IBM Corporation

Administering Access to Data Transfer

why “i"? it's simple.

IBM eServer iSeries

g Microsoft System Policies

FOLEDIT.EXE

 Data Transfer From iSeries - Limiting
downloads
— Prevent usage of Data Transfer From
iSeries
— Prevent usage of Data Transfer GUI
— Prevent usage of RTOPCB command
— Prevent autostart uploads
— Prevent usage of Excel-Add In
* Limiting users to only autostart
downloads will help to prevent them from
modifying transfer requests and keep
them from downloading any file they have
read access to on the iSeries.

© 2005 IBM Corporation

Administering Access to Data Transfer

=]
£ Default User Properties
Policies |
=10 IBM iSeries Access Runtime Restrictions |

U0 Data Transter
-4 Data Transfer Uploads
Prevent all Data Transfer to server
. =@ Data Transfer uploading options
-0 Data Transfer Downloads
H [E Prevert all Dats Transter from server
2|0 Data Transfer downloading options
: “[B Prevent Data Transfer GUI Downloads
Prevent usage of RTOPCE
Prevent aulostart dowrloads

; Prevent Excel add-n downloads
- Server e creation

@ Directory Update |
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g Microsoft System Policies

£ Default User Properties [ 2] x]
POLEDIT.ERE e |
» Data Transfer To iSeries - Limiting 510 ot e s e Rt =
- Data Transfer
up loads =\ Diata Transher Uplnads
— Prevent usage of Data Transfer To e Tl ok oo
1 i [ Prevent appending/replacing host files
|Ser|es . . E PIEVEH: D'?:a Trar?slerpﬁu\ ng\uatds
— Prevent appending to/replacing host Fievenl usage of RFAONFCE
fll es Prevent autostart uploads
Prevent Excel sdd-in uploads
~ Prevent usage of Data Transfer GUI s T
— Prevent usage of RFROMPCB @ Do Tomster dourioading opions
command @ Serve file creation =l

— Prevent autostart uploads

« Limiting users to only autostart uploads
will help to prevent them from modifying
transfer requests and keep them from Coc | oo
using Data Transfer in potentially =
harmful ways.
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£ Default User Properties [ 2] x]
FOLEDIT.EXE e |
» Data Transfer To iSeries - iSeries server E%Aésfne;m;ssHunumeﬂesmw 5|
file creation @ Data Tiansfer Uploads
@ Data Transter Downlnads
— Prevent creation of new files on the S .
ISeries ) u A ——
_ Prevent Creatlon Of fI|eS V|a the Data ce D"EDI;D:':[\;enl server file creation based on existi,
Transfer 8 Foaei
* Create iSeries Database File wizard J & @ Comnicatins | _>|;|
— Prevent creation of files via the standard
« "created based on" or Field Reference
File method.
Cancel
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Getting a system setup for policies

1.
2.
3.

Get the System Policy Editor from http://www.microsoft.com.

Open an MS-DOS window.

Go to the iSeries Access for Windows directory, normally located at:
[C:\Program Files\IBM\Client Access\

Run the cwbadgen /std command in the MS-DOS window. This
generates the caerestr.adm policy template needed to create the policy
file.

Note: for more information on policy support see:
http://publib.boulder.ibm.com/iseries/v5r2/ic2924/info/rzaii/rzaiiconfiguration.htm
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Getting a system setup for policies

S e o

Start the policy editor by double-clicking on poledit.exe.
Go to Options > Policy Template > Add.
Go to the location where you stored the .adm files that you created in creating
policy templates.
Select the .adm files that you want to add and press Add. Keep doing this until
you have added all the .adm files you want to use. Click OK.
Select File > New Policy.
Set your policies and save the policy file:
1. \QYOURSYS\POLICIES\config.pol (for Windows 95/98) -or-
2. \QYOURSYS\POLICIES\ntconfig.pol (for Windows NT)
Where:
*  QYOURSYS is the name of your iSeries NetServer.
* POLICIES is the name of the shared file folder on your iSeries NetServer.
*  (nt) config.pol is the name of your policies file.
* To update the policy file, open your policy file with the policy editor, make your changes and
save the file back to the above location.
* Note: You must create and maintain policies for the Windows 95/98/Me and Windows
NT/2000 separately. (Policies created for Windows 95 will not work on an NT system, and
vice-versa.)
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iSeries Navigator Application Administration

Application Administration {Local Settings) - Rchasdsb

*To get to Appllcatlon S s et e
Administration: iBeries Navigator  Client Applications | Host Applications |
. . . Function Defaull Access |l Object Aocess | Customized Aogess | ~
* Open iSeries Navigator = g :
250 Display and Printer Erulatar
i E Dat Transfer
L]
CIICk on the SyStem yOU 88 Download from server
o 84 GUI Downloads
want to administer Pl piabecd
) 20 Autostart Downloads
e Goto the F||e menu S Excel Addin Downloads
B0 Active Automation Dowrloads
H 1 3 Upload to server
and SeleCt Appllcatlon 9 Host File Creation
P . 2 Append Repl Haost Fil
Administration -> Local o G e
. 8 Uss of RFROMPCE
Setti ngs 3 Autostart Uploads _'Ll
q ¥
Fiemove Customizalion Clstonie
Applications K| Cancd | He |
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iSeries Navigator Application Administration

« Application Administration
— Provides similar capabilities as Microsoft PC based policies
— Administration information is stored on the iSeries
— Data Transfer options are stored on a per user/per iSeries basis
— Customize user access to Data Transfer functions
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iSeries host server exit programs
e Exit Programs
— Exit programs written for the QIBM_QZDA NDB, ROI, and SQL exit points
may help to restrict certain users from accessing specific files.
— Configured with WRKREGINF on the iSeries

— Given the SQL statement sent from the client application (Data Transfer).
Statements may be rejected by the user exit program

— May be written in a variety of host languages

Note: Data Transfer and ODBC use the same server for database access.

Currently, exit programs created for Data Transfer are also active for ODBC
users.
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Object-level database security

« All objects on the server, including SQL objects, are managed by the
system security function

e See:

« http://publib.boulder.ibm.com/iseries/v5r2/ic2924/index.htm?info/sqlp/rbaf
ymst324.htm
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ActiveX? Automation Objects? So what's this? What can they do for me?

ActiveX Automations are re-usable objects that reside on your
Windows PC. Many times they can be used to run an application by
"remote" with a program or script.

They work similarly to Object Linking and Embedding (OLE), used
for things like inserting an Excel spreadsheet into a WordPad
document. Not just cutting and paste, actually "linking" the
spreadsheet into the document.

ActiveX objects work much like this, except in the programming world.

© 2005 IBM Corporation Why .i-? it's Simp|e.

IBM eServer iSeries

Data Transfer ActiveX Automation Objects

So what can they do for me?

ActiveX automations can be used to quickly and easily perform many tasks
with little or no user intervention. For example, a program may use the
Automations for Microsoft Excel to perform various data calculations
without ever bringing up the Excel interface.

ActiveX automations can be used to create new custom interfaces
over applications that have ActiveX automations. A few examples are
Microsoft Office products, Internet Explorer, the PC5250 emulator, and
various iSeries Access for Windows functions.
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OK, how do | use them?
« ActiveX automations are supported by many programming languages
including:
— Visual Basic
— Visual Basic for Applications (used by Microsoft Office)
— Visual Basic Script (used in web pages and the PC5250 emulator)
— C++
— Java
— Lotus Script
— Many other applications and development environments
* You must write program code to use these objects. Or allow some
development tool to write the code for you.
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What Automations are available for Data Transfer?

« Two types of ActiveX Automations for Data Transfer
— High Level Automations
— Low Level Automations

« Labeled based on functionality and ease of use
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High Level Automations

Easier to use, but limited functionality!

With the high level automations you can run a Data Transfer with as little as 2 lines
of code!
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The High Level Automation Object

The name of this object is DatabaseTransfer

The DatabaseTransfer object can be used to run a simple upload, download,
or an existing transfer request file!
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Using the DatabaseTransfer Object

These two lines of Visual Basic (VB) code can be used to run a download:

Dim dt As New cwbx.DatabaseTransfer
dt.Download "mysys", "qiws/qcustcdt”, “c:\myfile.xIs", cwbdtBIFF5

To do an upload:
dt.Upload "mysys", “cwbxtest/qcustcdt"”, "c:\qcustcdt.txt", “c:\qcustcdt.fdf"
To run a saved request:

dt.Transfer "c:\qcustlst.dtf"
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Using the DatabaseTransfer Object

The DatabaseTransfer automation object also contains properties
you can query or set for the transfer request.

 Errors - for query only. A standard collection of error messages.
Messages get put into this collection while the request is running

« Password - Allows you to set the password for the iSeries connection
necessary for the transfer

« TransferResults - Allow you to get the number of rows transferred,
return codes, and error and warning locations.

» UserID - Allows you to set the user ID to use for this transfer request.
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The Low Level Automation Objects

e There are two main Low Level Objects:
— DatabaseDownloadRequest
— DatabaseUploadRequest
 Various properties must be set on these objects to perform an upload
or download
» Used with other Client Access Express Automation objects.
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Using the DatabaseDownloadRequest Object

The DatabaseDownloadRequest object can be used to programmatically perform
a download from the iSeries to a PC workstation. It contains 5 additional objects
that may be set to perform a download. Each of these objects has various
settings.

o DatabaseAS400File - Stores the name of the file or files to download.

o DatabaseDownloadPCFile - Stores the name of the PC file to download, plus
file options.

o DatabaseQuerySettings - Query settings for the download.

« DatabaseFormatOptions - Data/time format options.

o DatabaseUserLibraryList - A list of libraries to use with the request.
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DatabaseDownloadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various
tasks:

o Download - Run the configured download

DownloadAsync - Runs the configured download asynchronously
LoadRequest - Used to load a stored download request
SaveRequest - Used to save the current request

Cancel - Cancels a running Async request
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A simple Visual Basic program to run a download using the low level
DatabaseDownloadRequest object:

Dim dIr As New cwbx.DatabaseDownloadRequest
Dim myiSeries As New cwbx.AS400System
myiSeries.Define "mysystem"

myiSeries.UserID = "myUserID"
myiSeries.Password = "myPassword"

Set dIr.System = myiSeries

dir.AS400File = "qgiws/gcustcdt"”

dir.pcFile = "c:\myfile"

dIr.pcFile.FileType = cwbdtBIFF8

dir.Download
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Using the DatabaseUploadRequest Object

The DatabaseUploadRequest object can be used to programmatically perform an
upload to the iSeries from a PC workstation. It contains 3 additional objects that may
be set to perform an upload:

« DatabaseAS400File - Stores the name of the file or files to download.

o DatabaseUploadPCFile - Stores the name of the PC file to upload, plus file
options.

« DatabaseUserLibraryList - A list of libraries to use with the request.
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DatabaseUploadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various tasks:
o Upload - Run the configured upload
o UploadAsync - Runs the configured upload asynchronously
o LoadRequest - Used to load a stored upload request
o SaveRequest - Used to save the current upload request
o Cancel - Cancels a running Async request
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Asynchronous Methods

The DatabaseDownloadRequest and DatabaseUploadRequest objects have
asynchronous capabilities. This means the upload or download request can run "In
the background" while program execution continues. A running Async request may
also be cancelled by the main program.

The UploadAsync and DownloadAsync methods also pass events back to the
running program. These events are:

o StatusChanged - Indicates that something has changed, like the request has
completed, or there was an error, or a specific number of rows has been
transferred.

« UploadComplete - Indicates that an upload completed

« DownloadComplete - Indicates that a download completed
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More information

Additional Information on the iSeries Access for Windows ActiveX automation objects can
be found in the iSeries Access for Windows Toolkit.

This information can be found under the ActiveX section of the Database portion of the
Toolkit documentation.
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Sample Code Disclaimer

This material contains IBM copyrighted sample programming source code for your
consideration. This sample code has not been thoroughly tested under all conditions.
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function. IBM
provides no program services for this material. This material is provided "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF FITNESS FOR A
PARTICULAR PURPOSE, OR NON-INFRINGEMENT. SOME JURISDICTIONS DO
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE
EXCLUSIONS MAY NOT APPLY TO YOU. IN NO EVENT WILL IBM BE LIABLE TO
ANY PARTY FOR ANY DIRECT, INDIRECT, SPECIAL OR OTHER CONSEQUENTIAL
DAMAGES FOR ANY USE OF THIS MATERIAL INCLUDING, WITHOUT LIMITATION,
ANY LOST PROFITS, BUSINESS INTERRUPTION, LOSS OF PROGRAMS OR
OTHER DATA ON YOUR INFORMATION HANDLING SYSTEM OR OTHERWISE,
EVEN IF EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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